Table of Contents

Introduction ......................................................................................................................................................... 2
  About this Guide ........................................................................................................................................... 3

Starting TheBrain 7 with an Older Brain ........................................................................................................... 4

PersonalBrain is Now TheBrain .......................................................................................................................... 4

Link Enhancements ............................................................................................................................................. 4
  Selecting and Deselecting Links .................................................................................................................... 4
  Link Notes and Attachments .......................................................................................................................... 4
  Link Directionality .......................................................................................................................................... 5
    Setting Link Direction ................................................................................................................................... 7
    Setting Direction for Link Types ................................................................................................................ 7
  The Link Tool ................................................................................................................................................ 7
  Other Link Enhancements .............................................................................................................................. 8

WebBrain Integration .......................................................................................................................................... 10
  Start Up ....................................................................................................................................................... 10
  Brain Management ......................................................................................................................................... 10

Additional Enhancements .................................................................................................................................. 12
  Performance .................................................................................................................................................. 12
  Custom Reports ............................................................................................................................................ 12
  Notes ............................................................................................................................................................ 12
  Maximize Plex Button .................................................................................................................................... 12
  Transparency Button ..................................................................................................................................... 12
  Forget/Delete Button .................................................................................................................................... 13
  Instant Activate .............................................................................................................................................. 13
  Calendar ....................................................................................................................................................... 13
  SiteBrain .................................................................................................................................................... 13
  Linux Drag and Drop ..................................................................................................................................... 13
  Proxy Settings .............................................................................................................................................. 13
  Miscellaneous Enhancements ....................................................................................................................... 14

Index ................................................................................................................................................................. 15
Introduction

Welcome to TheBrain 7, the latest evolution of the ultimate digital memory! This version makes connecting your thinking to your work patterns even easier, providing optimal viewing and fluid brainstorming. Major additions include:

- Curvy links can have Notes and attachments
- Multi-directional links
- Integration with WebBrain
- New SiteBrain features
- New Calendar with multi-day event display
- And many other enhancements …

Figure 1. TheBrain Interface
Introduction

TheBrain 7 is backwards compatible, however once you open a Brain in version 7, some features will be incompatible with earlier versions. Be sure to make a backup copy of your Brain prior to opening it with version 7. If you would like to return to version 6, you will lose any link Notes and/or link attachments that were created in version 7. Also, after you reinstall version 6, you will need to rebuild your instant activation index by clicking the File menu, clicking Utilities, and then selecting Refresh Instant Activation Index.

About this Guide

This guide covers the new features and changes in TheBrain 7 that have been made since version 6. It is intended for people who are already familiar with version 6.
Starting TheBrain 7 with an Older Brain

You can make a backup copy of your Brain by creating a BrainZip. For more information on how to create a BrainZip, please watch our video tutorial at http://www.thebrain.com/support/tutorials/sharing/brainzips/ or see “Creating a BrainZip” in TheBrain 7 User Guide.

PersonalBrain is Now TheBrain

The software is now simply known as TheBrain. There is no longer a Core edition. The two editions of TheBrain are the Free edition and the Pro edition.

Link Enhancements

New curved link lines make it even easier to understand the relationships between Thoughts. Links are easier to highlight.

Selecting and Deselecting Links

- Click a link to select it. The link will be displayed, animated, and outlined prominently. Unrelated Thoughts and links will temporarily fade into the background.

- Click an empty area of the Plex to deselect a highlighted link. Clicking a Thought or another link also deselects the highlighted link.

- Clicking a selected link shows the context menu for the link. You can also right-click on a link to show the context menu without selecting the link.

Link Notes and Attachments

Just like Thoughts, links can now have Notes and attachments.
Link Enhancements

When you highlight or select a link, the Notes and Link tabs show the Notes, properties, and attachments associated with the link.

You can also open floating windows for link properties, attachments, and Notes.

**Link Directionality**

Links can now include a directional arrow pointing to or from the source Thought.
By default, links do not show a directional arrow. You can set a direction for the selected link from the Link tab.

- Non-directed links do not show any indication of either Thought being the source of the link.

- A directed link shows an arrow in the middle of the link. The link becomes animated when the mouse hovers on it. The animation shows movement from the source Thought toward the target Thought. This visual cue is particularly useful when there’s a link label. For example, for the link label “Inspired” (shown below), the link’s directional arrow shows that “Hank Williams” was a source of the inspiration for Elvis. This is also very useful when you want to represent flows between items like financial relationships.

![Figure 4. Hank Williams Inspired Elvis](image)

- One-way links appear when the source of the link is active and the source Thought is already visible.

- One-way links are indicated by an arrow with a rectangle at its base.

![Figure 5. One-way Link](image)
One-way links are useful where Thought A is relevant when Thought B is active, but Thought B is not relevant when Thought A is active.

For example, you may want to see what company a person worked for when the person is the active Thought. However, for a large company with thousands of employees, you may not want to see all of the employees when that company is the active Thought. Creating a “works for” link type and making it one-way is a good way to do this.

Setting Link Direction
- Click the icon to the left of the One-way check box on the Link tab to switch a link between non-directed, directed, and directed in the reverse.
- Select the One-way check box to make the selected a link one-way. This option must be unchecked in order to make a link non-directed.

Setting Direction for Link Types
- You can also set link direction for link types. The direction of a link type is inherited by instances of the type and can be overridden by the instance.

The Link Tool
The Thought tool now doubles as the Link tool. The tab label and the controls change automatically based on whether a Thought or a link is selected or highlighted.
Other Link Enhancements

- Link labels are always displayed, even when the link isn’t highlighted.

![Figure 7. Link Labels Displayed](image)

- You can now set a link’s label, color, and thickness independently of type. If the link attributes are set to the default values, these properties are inherited from the type. If you set new attributes, the settings override the values of the type.

- Links may now be up to 15 pixels wide.

- You can create link types from the link’s context menu.

- You can change the default thickness of links in the Look & Feel section of the Preferences dialog box.
Figure 8. Default Link Settings

- When you copy and paste Thoughts, the links between them, along with any Notes, attachments, and other properties associated with the links are copied as well.

- Synchronization updates links and their data automatically between Brains. Advanced link properties, including direction, one-way links, Notes, and attachments are not available via the Web client.
WebBrain Integration

Start Up

When you start, you must log in to your Brain account. This enables integration with any subscriptions you may have. The Welcome dialog box provides the ability to sign up for an account and also provides a link for choosing not to connect to any server.

![Welcome to TheBrain at Startup](image)

Figure 9. Welcome to TheBrain at Startup

Brain Management

When there is no Brain open, TheBrain shows a list of all your available Brains, both locally and online.
By default, Brains are listed according to how recently they have been accessed. You can also see the list of Brains be sorted alphabetically. All Brains that are locally available are shown first, followed by Brains that are available online.

You can open a Brain that isn’t shown in the list by clicking the File menu, then the Open Brain command. The next time the list is shown, it will include Brains from the new location.

Click on a Brain in the list to open it. The status of whether each Brain is available locally, online, or both is also displayed. Right-click on a Brain or click on the status to display a menu of options for that Brain, as seen below.
Additional Enhancements

Performance

- Animation and display is optimized for speed.
- Database storage is optimized for speed.
- Calendar performance is optimized.

Custom Reports

Now you can access a custom report on Thoughts that use link types.

Notes

The conversion of Notes to text when copying Thoughts as an outline with Notes has been improved.

Maximize Plex Button

You can click the button in the upper-right corner of the Plex to maximize the Plex area. Click the button again to restore the Plex to the previous size.

![Figure 12. Maximize/Restore Plex Button](image)

Transparency Button

The Transparency button has been removed. You can select Transparent Mode from the Window menu or the Plex context menu.
Additional Enhancements

**Forget/Delete Button**

Use the new trash can icon in the **Thought** tool to forget or delete a Thought.

**Instant Activate**

- Types are prioritized in results above normal Thoughts, just like Tags.
- Now you can find tags by using multiple word queries, not just the first word.

**Calendar**

- Events that span multiple days are drawn in the calendar as such, so they’re easier to see and understand.

![Figure 13. Multiple-Day Calendar Event](image)

- You can edit Calendar events and popups using the keyboard.

**SiteBrain**

A completely rebuilt version of SiteBrain is included, featuring broader browser compatibility, faster performance, and improved rendering.

**Linux Drag and Drop**

Drag and drop of files and URLs is supported in Linux.

**Proxy Settings**

Proxy settings can now be configured in the **Advanced** section of the **Preferences** dialog box.
Additional Enhancements

Figure 14. Proxy Settings

Miscellaneous Enhancements

- Improved expanded view layout.
- Improved sync progress feedback.
- Brain metadata including the name and home Thought are now synced.
- Up to 100 themes can be saved.
- You can undo and redo various commands in a single step. These commands include Paste Image and URL Image, Delete Multiple Thoughts, and Delete Multiple Files.
- And many more …
## Index

| B | Backup copy, 4 |
|   | Backwards compatibility, 3 |
| C | Calendar, 13 |
|   | Compatibility, 3 |
| D | Delete a Thought, 13 |
| E | Editions, 4 |
| F | Forget a Thought, 13 |
| I | Instant activation, 13 |
| L | Link tool, 7 |
|   | Links, 4 |
|   | context menu, 4 |
|   | defaults, 8 |
|   | deselect, 4 |
|   | directional arrow, 5 |
|   | link labels, 8 |
|   | one-way, 6, 7 |
|   | select, 4 |
|   | set direction, 7 |
|   | Linux, 13 |
| M | Maximize Plex, 12 |
| N | Notes Tool, 13 |
| O | Open a Brain, 11 |
| P | Proxy settings, 13 |
| S | SiteBrain, 13 |
|   | Start-up, 10 |
| T | Transparent mode, 12 |
| U | Undo and redo, 14 |